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The software described in this book is furnished under a license agreement 
and may be used only in accordance with the terms of the agreement.

Copyright Notice

Copyright © 2000 WebGain, Inc.

All Rights Reserved.

This document may not, in whole or in part, be copied, photocopied, 
reproduced, translated, or reduced to any electronic medium or machine- 
readable form without prior consent in writing from WebGain, Inc., 5425 
Stevens Creek Blvd, Santa Clara, CA 95051, USA. 

ALL EXAMPLES WITH NAMES, COMPANY NAMES, OR COMPANIES THAT 
APPEAR IN THIS MANUAL ARE IMAGINARY AND DO NOT REFER TO, OR 
PORTRAY, IN NAME OR SUBSTANCE, ANY ACTUAL NAMES, COMPANIES, 
ENTITIES, OR INSTITUTIONS. ANY RESEMBLANCE TO ANY REAL 
PERSON, COMPANY, ENTITY, OR INSTITUTION IS PURELY 
COINCIDENTAL. 

Every effort has been made to ensure the accuracy of this manual. 
However, WebGain makes no warranties with respect to this 
documentation and disclaims any implied warranties of merchantability 
and fitness for a particular purpose. WebGain shall not be liable for any 
errors or for incidental or consequential damages in connection with the 
furnishing, performance, or use of this manual or the examples herein. The 
information in this document is subject to change without notice. 

Trademarks

Spin, WebGain, and the WebGain logo are U.S. trademarks of WebGain, 
Inc.

Other product names mentioned in this manual may be trademarks or 
registered trademarks of their respective companies and are the sole 
property of their respective manufacturers.

Printed in the United States of America.
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WebGain LICENSE AND WARRANTY
The WebGain software which accompanies this license (the "Software") is the property of WebGain or its licensors 
and is protected by copyright law. While WebGain continues to own the Software, you will have certain rights to 
use the Software after your acceptance of this license. Except as may be modified by a license addendum which 
accompanies this license, your rights and obligations with respect to the use of this Software are as follows: 
� You may: 

(i) use one copy of the Software on a single computer; 
(ii) make one copy of the Software for archival purposes, or copy the software onto the hard disk of your 

computer and retain the original for archival purposes;
(iii) use the Software on a network, provided that you have a licensed copy of the Software for each computer 

that can access the Software over that network; 
(iv) after written notice to WebGain, transfer the Software on a permanent basis to another person or entity, 

provided that you retain no copies of the Software and the transferee agrees to the terms of this agreement; and 
(v) if a single person uses the computer on which the Software is installed at least 80% of the time, then after 

returning the completed product registration card which accompanies the Software, that person may also use the 
Software on a single home computer. 

(vi) include object code derived from the WebGain component (java source or class) files identified below in 
programs that you develop using the Software and you may use, distribute, and license such programs to third par-
ties without payment of any further license fees, so long as a copyright notice sufficient to protect your copyright 
in the program is included in the graphic display of your program and on the labels affixed to the media on which 
your program is distributed. You may make changes to the WebGain components, but only to the extent necessary 
to correct bugs in such components, and not for any other purpose. You may include unmodified (except as stated 
in the previous sentence) WebGain component files required by your programs, but not as components of any de-
velopment environment or component library you are distributing. The Java Virtual Machine (VM) is not part of the 
WebGain component files to which you have the rights described in this paragraph.
� You may not:

(i) copy the documentation which accompanies the Software;
(ii) sublicense, rent or lease any portion of the Software;
(iii) reverse engineer, decompile, disassemble, modify, translate, make any attempt to discover the source code 

of the Software, or create derivative works from the Software; or
(iv) use a previous version or copy of the Software after you have received a disk replacement set or an up-

graded version as a replacement of the prior version, unless you donate a previous version of an upgraded version 
to a charity of your choice, and such charity agrees in writing that it will be the sole end user of the product, and 
that it will abide by the terms of this agreement. Unless you so donate a previous version of an upgraded version, 
upon upgrading the Software, all copies of the prior version must be destroyed.
• Return Rights: 

If you are not satisfied with this copy of the Software for any reason, please check with the dealer from which you 
purchased this copy to determine whether that dealer offers any right to return the Software for a full or partial 
refund.
• Limited Warranty:

WebGain warrants that the media on which the Software is distributed will be free from defects for a period of sixty 
(60) days from the date of delivery of the Software to you. Your sole remedy in the event of a breach of this warranty 
is that WebGain will, at its option, replace any defective media returned to WebGain within the warranty period or 
refund the money you paid for the Software. WebGain does not warrant that the Software will meet your require-
ments or that operation of the Software will be uninterrupted or that the Software will be error-free. 
THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, WHETHER EXPRESS OR IM-
PLIED, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
AND NONINFRINGEMENT. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER 
RIGHTS, WHICH VARY FROM STATE TO STATE.
• Disclaimer of Damages:

REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN NO 
EVENT WILL WEBGAIN BE LIABLE TO YOU FOR ANY SPECIAL, CONSEQUENTIAL, INDIRECT OR SIMILAR DAM-
AGES, INCLUDING ANY LOST PROFITS OR LOST DATA ARISING OUT OF THE USE OR INABILITY TO USE THE 
SOFTWARE EVEN IF WEBGAIN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSE-
QUENTIAL DAMAGES SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.
IN NO CASE SHALL WEBGAIN�S LIABILITY EXCEED THE PURCHASE PRICE FOR THE SOFTWARE. The disclaimers 
and limitations set forth above will apply regardless of whether you accept the Software. 
• U.S. Government Restricted Rights:

RESTRICTED RIGHTS LEGEND. Use, duplication, or disclosure by the Government is subject to restrictions as set 
forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-
7013 or subparagraphs (c) (1) and (2) of the Commercial Computer Software-Restricted Rights clause at 48 CFR 
52.227-19, as applicable, WebGain, Inc., 5425 Stevens Creek Blvd., Santa Clara, CA 95051, USA.
Export Law Assurances: 
You acknowledge and agree that the Software may be subject to restrictions and controls imposed by the United 
States Export Administration Act and the regulations thereunder. You agree and certify that neither the Software nor 
any portion thereof will be acquired, shipped, transferred or exported, directly or indirectly, into any country or in 
any manner prohibited by applicable law or regulation.
Term and Termination:
This Agreement is effective until terminated. You may terminate this Agreement at any time by destroying the Soft-
ware including all copies or updates thereof. This Agreement will immediately and automatically terminate without 
notice if you fail to comply the any term or condition of this Agreement. You agree upon termination to promptly 
destroy the Software including all copies or updates thereof.
• General:

This Agreement will be governed by the laws of the State of California. This Agreement may only be modified by a 
license addendum which accompanies this license or by a written document which has been signed by both you 
and WebGain. Should you have any questions concerning this Agreement, or if you desire to contact WebGain for 
any reason, please write: 
WebGain Customer Service, 5425 Stevens Creek Blvd., Santa Clara, CA 95051, USA
iv
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Spin Installation Guide

This document explains the installation and configuration of Spin. For the Spin 
Beta release, this document focuses on installation and configuration on Windows 
(2000 and NT) platforms.

Introduction
Spin uses an installer (InstallAnywhere from ZeroG) to make installing Spin as easy 
as possible. For most users, installing Spin consists of downloading the appropriate 
installer for your platform from the Spin download page, then executing it. In 
addition to Spin, the installer also installs the PointBase DBMS (DataBase 
Management System), for building database-enabled Web applications. On 
Windows platforms, the installer also installs the appropriate JRE (Java Runtime 
Environment) and Java compiler.

On all platforms except Windows, Spin requires a JDK (Java Developer's Kit) or 
SDK (Software Developer's Kit) to run (not just a JRE (Java Runtime 
Environment) or JVM (Java Virtual Machine)), because it requires a Java compiler 
to compile scripts. On Windows a JRE will do because Spin installs a separate 
compiler.

After you install Spin, we strongly encourage you to work through the examples in 
the Spin Tutorial. This will give you a quick introduction to Spin.

Platform-Specific Information
For the Spin Beta WebGain only officially supports and provides installers for 
Windows. Note that exactly the same version of Spin runs on all platforms, and 
installers will be provided for other platforms in future releases.
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Applications created using Spin should run on any computer that has a Java Virtual 
Machine (unless you use any components that have platform dependencies).

 Windows 95, 98, NT, and 2000

Spin requires Windows NT version 4.0 or Windows 2000.

The installer will ask you to select a Java Virtual Machine for your application. The 
default is "Install JRE specifically for this application." This choice installs Sun's 1.3 
JRE and IBM's Jikes compiler. We strongly encourage you to run Spin using this 
version of Java. You should do this even if you already have a different version of 
Java installed on your computer. Windows can have multiple versions of Java 
installed at the same time.

The only reason to use a different version of Java is if you are using components in 
Spin that require a specific version of Java (for example, Java 2). In this case, that 
Java version must be installed before you install Spin. When you install Spin, the 
installer will let you select the version of Java that you want to use.

In addition to the Sun 1.3 JRE, Spin is compatible with Sun's JDK 1.1.8, IBM's 
JDK 1.1.8, and Java 2 SDK (JDK 1.2).

Invoking Spin
The files lax.jar, Spin.exe, and Spin.lax are files used by LaunchAnywhere to launch 
Spin on Windows. On other platforms, the file names may be slightly different (e.g., 
on Macintosh, Spin.exe is just called Spin). You do not actually need these files to 
run Spin, they just make it more convenient. Spin is written entirely in Java, and the 
same program runs on all supported platforms.

You can invoke Spin directly. For example, on Windows, you can create a .bat file 
containing the following command (this should all be on one line):

java -classpath 
%classpath%;spinlib.jar;app.jar;load.jar;comp.jar;servletsupt.jar;servletdebug.jar;ejbs
upt.jar;servlet-
2.2.0.jar;tomcat.jsr;swingall.jar;libraries/jrad.jar;HTMLWindow.jar;pointbase/classes
/pbnetwork31RE.jar;pointbase/classes/pbclient31RE.jar;beans/ejb;. 
com.webgain.spin.editors.Spin

Note that swingall.jar is not needed if you are using Java 1.2 or Java 1.3 as those 
versions of Java include Swing.
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A similar command could be used on UNIX in a shell script. On the Macintosh, a 
similar command - created using JBindery - is provided in the file Spin.bin, which 
you can expand using StuffIt Expander and use instead of the installed application 
file 'Spin'.

Using Spin with Java 2
The easiest way to use Spin with Java 2 is to use the 1.3 JVM provided with Spin's 
installer.

You can run the same copy of Spin on multiple versions of Java. To do this do not 
use the CLASSPATH or PATH system variables at all. Instead create a .bat file 
(Windows) or shell script (UNIX) to run Spin, as described in the previous section. 
Then use the -classpath option to completely list the files you want in your 
classpath, without referencing "%classpath%" (Windows) or "$CLASSPATH" 
(UNIX). Also specify the full path to the "java" or "jre" command, so you do not 
use the PATH variable either. You will need a separate file (.bat or shell script) to 
invoke Spin, one for each JDK.

On some platforms, including Linux, the Java 2 compiler is not made available to 
the Java runtime by default. In this case, you will see a message like "Spin cannot 
find the Java compiler. Spin requires a JDK or SDK to run, and will not work with 
just a JRE". In this case, you must include the file containing the compiler in your 
classpath. For example, if Java 2 is installed in /opt/jdk1.2.2, you would specify 
/opt/jdk1.2.2/lib/tools.jar in your classpath.

Using Spin with EJBs
The easiest way to use Spin with EJBs is to use the 1.3 JVM provided with Spin's 
installer. If you use the jBoss EJB server that ships with Spin, Spin sets your 
classpath so that jBoss can be found and executed properly.

If you plan to use an EJB server other than the jBoss that ships with Spin, you 
must add classpath entries for your EJB application server to the classpath 
environment variable. Spin will add this classpath to its own classpath and resolve 
the .jars necessary to support EJBs.

For example, to use Spin with WebLogic 5.1 installed on c:\weblogic add the 
following to the end of your classpath:
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;c:\weblogic\classes;c:\weblogic\lib\unpacked_jars\javax_j
ts.zip;c:\weblogic\lib\unpacked_jars\jsafeWithNative.jar;
c:\weblogic\lib\weblogicaux.jar

Installation Files and Directories
Spin is installed into the directory you specified during the installation. This 
directory contains the following subdirectories:

◆ asset - Contains any images, sounds, animations, and other asset files used by 
the example programs. 

◆ beans - Contains all JavaBeans used as actors. To add a new actor JavaBean to 
Spin, simply drag it into this directory and restart Spin. 

◆ beans/ejb - EJB .jar's are copied here and expanded when used by Spin. 
behaviors Where all user-defined behaviors are stored.

◆ docs - Contains JavaDoc documentation for JavaBeans. If you add a new 
JavaBean to the beans directory, you can store its JavaDoc documentation here, 
and Spin will find it. 

◆ dtd - Contains dtds used by Spin's XML facilities. 

◆ examples - Contains client-side example programs. This is a convention only; 
you can put Spin projects and capsules anywhere. 

◆ icons - Spin icons 

◆ jikes - The Jikes Java compiler from IBM. Installed on Windows only. 

◆ jre - The Java Runtime Environment from IBM. This directory only exists if 
you used the Windows Spin installer that includes Java. 

◆ pointbase - The PointBase DBMS (DataBase Management System). Used to 
develop database applications with Spin. 

◆ public_html - Where the Spin debug web server expects to find html files. The 
location of this directory can be changed using a Spin preference. 

◆ exampleservlets - Contains server-side example programs. This is a convention 
only; you can put Spin projects and capsules anywhere. 

◆ sources - Spin uses some Java code whose source is freely available. We include 
that source code here for you. 

◆ temp - Spin uses this directory to hold intermediate results when "grinding 
beans" or processing .jsp's. 
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◆ UninstallerData - Contains files used to remove Spin from your system, 
including a log of all actions taken during the installation of Spin. This directory 
only exists on certain platforms.

The main Spin directory contains some .properties files that are used by Spin.

◆ The files DebugServer.properties, General.properties, GetInfo.properties, 
ScriptOptions.properties, and EnterpriseJavaBeans.properties are managed by 
Spin; you can modify them by choosing "Preferences" under the Edit menu.

◆ The file content-types.properties describes the MIME types understood by 
Spin's internal web application server. You can edit this file if necessary.

◆ The file spinsql.properties specifies the databases and database drivers available 
to the ZatSQL database components. You must edit this file if you want to use 
Spin with another database. See the Database section of this document for 
more information.

The main directory contains nine jar files used by Spin.

◆ The files app.jar, zatload.jar, and servletdebug.jar contain Spin itself. You may 
not make copies of these files in any form (except for backup purposes).

◆ The files spinlib.jar, servletsupt.jar, comp.jar, and tomcat.jar contain files that 
are used by projects built with Spin. You must deploy these files with any 
application, applet, servlet, or component that you build using Spin. comp.jar 
and tomcat.jar are only required if you use JSPs within your Spin application. 
Additionally, servletsupt.jar is not required if all you are creating is a client 
application.

◆ The file servletsupt.jar must be deployed with any servlet built with Spin. You 
only need to deploy it with applications, applets, or components if they contain 
servlet capsules. The file servlet-2.2.0.jar is Sun's Java Servlet SDK. This file 
should be deployed with any servlets you build, unless your servlet 
environment already includes this file (and most of them do include it).

◆ The file swingall.jar contains the Java Swing GUI widgets.

◆ The file lax.jar contains LaunchAnywhere, which makes it possible to run Spin 
by double clicking on it.
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LEGAL NOTICE: As described in the WebGain Binary License Agreement, in the 
file License.txt, the term "WebGain Components" includes the files spinlib.jar, 
servletsupt.jar, and comp.jar as well as most of the files found in the "beans" 
subdirectory of the Spin installation. These WebGain Components may be 
redistributed with an application, applet, servlet, or component built using Spin, but 
they may not be used for any other purpose. The file SpinSQL.jar in the "beans" 
subdirectory may be deployed onto a single server, but if you want to deploy it onto 
additional servers, you must license it from WebGain (or simply purchase additional 
copies of Spin). No other files in the Spin installation can be redistributed in any 
form. See the WebGain Binary Licence Agreement for more information.

Documentation
There are two kinds of documentation that come with Spin. One is the Spin 
manuals, like this one. The other is the JavaBean documentation generated by 
JavaDoc, used by the Spin GetObjectInfo command to display information about 
JavaBeans used in Spin.

Spin Manuals

You can access the manuals online, in one of several ways:
◆ From the Spin "View" menu, using the "Spin Documentation" command.
◆ From any browser, by accessing the URL 

http://www.zat.com/documentation.html.
◆ The Spin installation also generates an icon that will take you directly to this 

Web page in your default browser.

GetObjectInfo Documentation

Spin can display documentation for any JavaBean component used as an actor in 
Spin. This documentation is generated by JavaDoc from the source for each 
component.

In general, Spin components come from three places:
◆ Components that come with Spin, including the HTML beans, visual beans like 

Text and Rect, and non-visual beans like Clock and SqlSelect. 
◆ Components that come with Java, including AWT components like Button and 

Scrollbar. 
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◆ Components you add later, or that you write yourself.

JavaBean documentation is displayed using the Spin Get Object Info command. 
This command is found in both the View menu and the Actor menu. There is also 
a keyboard shortcut, Control-I (Command-I on the Macintosh), or you can use the 
right mouse button menu (Command-click on the Macintosh).

To display online documentation for a JavaBean, the Get Object Info command 
must be able to find the documentation:
◆ For the JavaBeans that come with Spin, Spin automatically installs 

documentation docs subdirectory of the Spin installation directory. 
◆ For JDK documentation, Spin accesses this documentation from Sun's website. 
◆ You can add JavaBeans to Spin by placing them in the beans subdirectory of 

the Spin installation directory. When you do this, you should also add any 
corresponding JavaDoc documentation to the docs subdirectory of the Spin 
installation directory. JavaBeans you acquire should come with JavaDoc 
documentation.

JavaDoc documentation is always in HTML format, but there are two ways that this 
documentation can be named: using dot notation or using directory notation. For 
example, the Time JavaBean in the com.webgain.misc package can be named 
com.webgain.misc.Time.html, or it can be named com/webgain/misc/Time.html. 
Use backslashes ( \ ) instead of forward slashes with Windows, and use colons on a 
Macintosh). Spin can use either format. The Spin JavaDoc documentation uses 
directory-based filenames because the dot notation results in file names that exceed 
the maximum allowable file name length on some platforms.

Offline Documentation

The Spin manuals are normally accessed from the Webgain website, and the JDK 
JavaBean documentation is normally accessed from Sun�s website. Accessing the 
documentation online ensures that you are always viewing the latest version of the 
documentation. If you need to use Spin without an Internet connection, you can 
download and install a local copy of both kinds of documentation, if desired.

You can download a complete set of Spin manuals from the download Web page 
referenced above.

To install the JDK JavaBean documentation, you need to download it, install it, 
then set a preference so that Spin can find it.

First, you need to download the JDK documentation from Sun. This can be 
downloaded from http://java.sun.com/products/jdk/1.1/docs.html. Like all 
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JavaDoc documentation it is in HTML format, and is identical for all platforms. If 
you are using Spin with another version of Java, such as Java 2 (JDK 1.2), you need 
to download its documentation instead.

Unpack this documentation into an appropriate directory, such as the docs 
subdirectory of the Spin directory, or (if you are using some other version of Java) 
the docs subdirectory of your JDK directory. The JavaDoc documentation we are 
interested in is in the "api" subdirectory of the unpacked docs directory.

Finally, you need to change a preference so that Spin can find this documentation. 
From inside Spin, go to the Edit menu and choose Preferences. Set the Spin 
preference JDKDocsDirectory (in the General tab) to the api subdirectory of the 
JDK docs directory.

Installing Components
Installing new components in Spin is easy. For simple components, you only need 
to copy the components into the beans subdirectory of your Spin installation 
directory and restart Spin. If the components come with JavaDoc documentation, 
that documentation should be copied into the docs subdirectory of the Spin 
installation directory.

If the beans use any assets, they can be placed into the asset subdirectory of the 
Spin installation directory (but this is only a convention, and is not required).

If the components have any libraries, these will need to be installed onto your 
system using the instructions provided with these libraries. You will also probably 
need to set your system CLASSPATH to allow Java to access these libraries.

Upgrading Components
Sometimes new versions of specific components can prevent you from opening an 
existing capsule you have built with Spin. While the JavaBeans component 
architecture provides facilities so that JavaBeans can automatically upgrade 
themselves to new versions, sadly, most JavaBeans authors do not implement this 
feature. For most JavaBeans, the only way around this problem is to open the 
capsule using the old version of the component, and manually remove all instances 
of that component. Then replace the old component with the new component in 
the beans subdirectory, and restart Spin. Finally, open your capsule and insert 
instances of the new component in all the proper places.
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Installing a Media Library

If you want to use Spin to build client-side rich media applications, you will need to 
install a media library and components to access that media library. We have used 
Spin with the Quicktime libraries from Apple and with the Java Media Framework 
but we do not support these libraries.

Installing QuickTime is not especially difficult, there are just lots of steps. First, you 
must install the latest version of Quicktime on your system. For playback you don't 
need the Pro version, the free version is fine. Note that there are versions of 
QuickTime only for Mac and PC, so if you are on some other platform, you're out 
of luck. For other platforms, you can try the Java Media Framework instead.

When you install QuickTime, be sure to install the QuickTime for Java libraries. 
You can also download and install QuickTime for Java separately. This is a set of 
Java classes that give access to QuickTime from Java. These classes must be added 
to your CLASSPATH so that Spin can find them.

At this point, you can access QuickTime calls from within Spin scripts, but what 
you really want is QuickTime-enabled JavaBean components. There are two sources 
for QuickTime components: from Elegant Chaos and from Tiger Island. These 
two sources have different capabilities. Finally, you need to install these 
components into the beans subdirectory of the Spin installation directory.

Reinstalling and Upgrading Spin
You can install a new version of Spin over an existing version. We highly 
recommend that you back up your existing Spin installation before installing a new 
version over it. 

Database
Spin includes a copy of the PointBase DBMS (DataBase Management System). 
This copy is for development purposes only, and must be licensed from PointBase 
if you wish to deploy it in a commercial application. Also, the free development 
copy is restricted to 5 MB total database size.

Spin installs several shortcuts for PointBase (in a directory, the start menu, or on 
the desktop, depending on what you chose when you installed Spin and what 
platform you are running on). These are:
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◆ PointBase Server - Starts the PointBase DBMS. You can also have PointBase 
start automatically when Spin starts by selecting the 
PointBaseServerLoadsAtStart preference in the General tab of Spin 
Preferences (in the Edit menu).

◆ PointBase Console - Used to manage your database, including setting up 
database schema. See the PointBase documentation for more information.

◆ PointBase Documentation - In PDF format, so you will need the Adobe 
Acrobat Reader.

Spin comes preconfigured for the PointBase DBMS. To use Spin with other 
databases, you must configure them in the spinsql.properties file. Spin should work 
with any database that has JDBC drivers. See the Spin Database documentation for 
more information.

Dreamweaver Extensions
Spin now ships with extensions for Macromedia Dreamweaver. If you use 
Dreamweaver and would like to use these extensions, do the following to install 
them.

1 If you have not already done so, download the Dreamweaver Extensions 
Manager from:
http://dynamic.macromedia.com/bin/MM/exchange/
dreamweaver/main.jsp

2 Make sure that Dreamweaver is not open, then install the Extensions 
Manager that you downloaded.

3 Select Manage Extensions from the Dreamweaver Commands menu.
4 Select Install Extension from the Extension Manager File menu.
5 Select the file Spin\Dreamweaver Extensions\WebGainSpinTags.mxp
6 Accept the Macromedia Extensions Disclaimer.
7 Exit Dreamweaver.
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